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January 2004 Volume VIV  Number 1 

By Sheldon Plotkin 
 
 I wish everyone a happy and 
prosperous new year.  Members 
of “Let’s Compute” computer 
club should look forward to the 
extended class schedule. Take 
note of new classes that are in-
cluded in this month’s  listing.   
 Your Board of Directors have 
been very concerned with regard 
to security of all our computers 
in the lab. As a result of our dis-
cussions, Pete Claar, who is 
maintaining the operation of the 
computers, agreed to form a 
Maintenance Team to develop a 
security program for our com-
puters. The individuals on this 
team will work individually and 
collectively to develop a security 
program under the direction of 
Pete.  Many hours have been 
spent by the Team and I would 
like to acknowledge the people 
involved; Dick Franzen, Wal-
ter Goldsmith, Barbara Kaye, 
Kent McDonald ,Dale Seffer, 
Jack Drill, Dick Scarpulla, 
Kerry Greene and Pete Claar 
As we progress with this pro-
gram, we will present a report at 
a future date. 
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By Jim Calvert 
  
 January is the month the com-
puter club “kicks it up a notch.”  
Everyone is back, and we don’t 
have to work around holidays.  
This month you will have over 
eighty hours of quality computer 
classes to choose from.  Some 
will be familiar, and others will 
be new.  In some cases, we have 
more than one teacher presenting 
classes using the same software.  
That doesn’t mean the classes 
are the same.  The teachers are 
teaching from their own personal 
experience, and classes that look 
the same will be different. 
 All of the Macs have Photo-
Shop CS and PhotoShop Ele-
ments 2 installed on them. Also 
all of the PCs have Photoshop 
CS, Photoshop Elements 2, and 
Adobe Photoshop Album.  At 
leas 10 PCs have WordPerfect 
Word Processor, Quatro Pro 
Spreadsheet, Paradox Data Base, 
and Works Suite 2002 installed 
on them for hands on classes.  
All we need now is more teach-
ers.  You don’t have to be an ex-
pert to share your knowledge.  
Most of us aren’t.  If you can  

Continued on page 2 

THE  JANUARY  
MEETING PROGRAM 

 

Demystifying Inkjet Printing 
 

 This month our speaker will be 
Don Baker of Klassicspecalities.  
Several of us heard Don speak 
at the Southwest Users Group  
meeting in San Diego and found 
him extremely informative.   
 Don will cover the following 
topics: 
• Basic Theory of Opera-

tion: differences between 
HP, Canon, Lexmark and 
Epson.   

• Cost of Operation:  OEM 
cartridges vs Compatible vs 
refilling.   

• Selecting a Printer:  Con-
siderations and explanation 
of some of the marketing 
statements. 

• Photo vs 4-color, and future 
trends 

• Media and alternataives 
 
 He’ll also discuss printing and 
scanning tips … and more.  If 
you want to visit the company’s 
website, go to 
www.klassicspecialties.com. 
 Remember, General Meetings 
are at 2:00 in the Speaker’s Hall.  
Don’t forget to sign in and get 
your ticket for the door prize 
drawing. 



2 

By Jill Johnson 
 A very entertaining evening 
was had by all 23 members, in-
cluding 4 new members, at our 
December 10th Meeting.  Jan 
Grenert was our moderator.  
Several interesting topics were 
discussed, one of which was 
the  new and handy device called 
a "Thumb Drive".....an external 
USB  storage device.  Jim Cal-
vert had one in his pocket and 
did a quick demonstration on 
how they work.   
 We were entertained with a 
beautiful "Slide Show" by John 
Wolfersberger. His presentation 
consisted of “same location” 
photos that he had taken over the 
past year near the #4 tee of the 
Santa Rosa Course The view  
includes the fairway, lake and 
the San Jacinto Mountains.  John  
produced a spectacular "Slide 
Show" of 140 Photos, depicting 
all weather conditions, including 
sunrises & sunsets.  On his night 

Calvert’s Corner  
(Continued from page 1) 

teach even one session, your ef-
forts will be appreciated.  Con-
tact me:  772-6710, 
Jim2anna@aol.com or in the lab  
any day from ten till noon and I 
will help you get started. 

Eleanor Gabel, who teaches 
classes with Photoshop Elements 
2 for Mac users, is moving away 
from our community in Febru-
ary.  We will miss her and want 
her to know that her efforts here 
were appreciated.  This month is 
the last chance for Mac users to 
take her classes.  Don’t miss out. 

 

views, He explained that he used 
a 10 second delay on his cam-
era.  The camera he used was a 
Sony Cybershot 4.1 mega 
Pixel.  He also printed all the 
photos and made a lovely 
"Coffee Table" Book.  We cer-
tainly thank John for his efforts 
in sharing his talent and patient 
undertaking over the past year. 
This motivated us to try and 
make a "Slide Show",also John 
agreed to teach a Photo Shop 
class in January. 
  For  our next meeting, on 
January 14, 2004, bring your 
cameras and we will give over-
views of each of them and share 
techniques, successes and prob-
lems with solutions.    
 Also, Jim Calvert will give a 
demonstration of how to copy a 
DVD from a CD, as we are all 
eager to learn this. 
  We wish you all a very Happy 
New Year and a year full of new 
Digital ideas, experiments and 
improvements in our expertise. 

 

By Kerry Greene 
 December was a busy month 
for all of us, but a large number 
of Windows enthusiasts made 
time for our meeting on the 17th 
of the month, and they are glad 
they did. 
 With only a week to go before 
Christmas, we were shown a 
great stocking stuffer for all 
computer owners – PC and 
MAC!  Called a ‘Thumb Drive’, 
this handy little storage device 
plugs into any USB port, allow-
ing the user to quickly transfer 

any type of data to it for viewing 
or copying to another computer.  
It is solid state ‘flash memory’, 
available in 32 – 512 Mb sizes, 
and is not much bigger than a 
house key.  With floppy disc 
drives disappearing from new 
computers, the high capacity, 
totally re-writeable Thumb Drive 
is the wave of the future. 
 If you don’t have enough 
USB ports for these new de-
vices, get a powered hub, which 
will add four to six ports and put 
them within easy reach.  Hubs 
are simple – just plug in and you 
are ready to go!  Powered hubs 
require an A/C outlet, but allow 
you to connect any type of de-
vice without drawing on the 
power supply from your com-
puter. 
 Pat Palladino had a great new 
slide show for us, this time using 
PhotoShow2 from Simple Star.  
This nifty little program is easy 
and fun to use, and the free trial 
(PC or MAC) is available at 
h t tp: / /www.photoshow.net /
get_photoshow/.  Larry Allen 
gave us a quick demonstration, 
showing us how to quickly cre-
ate a slide show using our own 
pictures and music, with finish-
ing touches that add clip art, cap-
tions and transitions.  Your crea-
tion can then be posted to a web 
site – simply email the link to 
your family and friends for them 
to enjoy your slide show!  Great 
job, Pat and Larry – this was so 
much fun!  Get more details and 
learn how to do this by taking 
Larry Allen’s classes, offered in 
January on the 5th and again on 
the 19th, at 2:00 pm. 
 What new discoveries await us 
in Windows?  Come to the next 
meeting on January 21st at 7:00 
pm and have some fun with us! 
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By Shirley Allan 
 

 Did you get a new Macintosh 
for Christmas? Basic Beginning 
Macintosh is a new class on 
January 14 being taught by 
Shirley Allan. The class is espe-
cially for those new to com-
puters. It is being taught in Jag-
uar (Operating System 10.2). 
The basics will include  the use 
of the mouse, keyboard, menu 
bar, folders and visual clues 
common to all Macintosh pro-
grams and more.  Questions are 
the foundation for learning for 
both the student and the teacher, 
so  questions about your Macin-
tosh are encouraged during the 
class. 

 We are pleased to introduce a 
new instructor  John Wolfersber-
ger who will be teaching classes 
he has titled “Having Fun With 
Photoshop”  
  Classes will be held on January 
5, 12, 19, 22, 2004.  Sign up 
sheets are in book 6. 
 Here’s a brief biography from 
John. 
 “We moved to Sun City Palm 
Desert a year ago in December, 
2002.  I retired two years ago as 
a clergyman for the Christian 
Church. I served congregations 
in Kansas, Oklahoma and South-
ern California. I also served as a 

Regional Minister (Bishop) in 
Kansas City, Indianapolis, and in 
Southern California. Marsha, my 
wife of 46 years, retired in June 
2002 as Executive Director of 
the Claremont Community 
School of Music.   
 My chief recreational activity 
through the years has been jog-
ging. My chief hobby has been 
as a watercolor artist. Three 
years ago I took up digital pho-
tography. I have taken about 
13,000 photos, which I keep or-
ganized with Windows XP. My 
camera is a Sony Cybershot 4.1 
Mega Pixel  with a 6X optical 
zoom. It’s memory stick is com-
patible with my Sony Computer 
and Widescreen Sony TV. With 
the awesome Photoshop 7  (now 
8) program I have added “photo 
art” to photography.  Photoshop 
enables one to combine, enhance 
and add endless effects, which 
evoke interest and stir the crea-
tive juices.”   

Many classes and teachers are 
making a re-appearance in Janu-
ary. Look for: 
 

Dick Franzen—PC Security 
 

Jim Chapman—Quicken  and 
Streets & Maps. 
 

The Golden Gals—Pictures and 
Projects and Crafts from photos. 
 

Doris Keniry—Print Shop  
 
 

By Lyn Morse 
 
 Something New This Way 
Comes - to paraphrase a famous 
story.  The Big Three, Office 
Depot, Office Max and Staples, 
will be present at our General 
Meetings. If you haven’t been 
saving your empty printer ink 
cartridges, start now.  We’ll be 
doing a limited number of swaps 
of cartridges for reams of paper 
at each meeting.  The only car-
tridges that will be accepted are 
Epson, HP and Lexmark. 
 At the January meeting, I will 
have 20 reams of paper to give, 
one ream to each of 20 people – 
first come, first served – who 
hand me an empty cartridge.  
This is a self-perpetuating ex-
change;  those cartridges will be 
exchanged for the next month’s 
paper.  The number of reams 
available may differ from month 
to month, so you’ll need to 
watch Bits and Bytes for that 
information. 
 Of course, you can visit Office 
Depot and take in one cartridge a 
day in exchange for a ream of 
their recycled paper (I use recy-
cled in both my printers);  you 
can go to Staples and Office 
Max and mention to them that 
Office Depot has an ongoing ex-
change, and they will also do a 
“comp” or swap.   When you go 
into any of these three, don’t for-
get to mention you’re from Let’s 
Compute Sun City.  The manag-
ers I spoke with at Office Max 
and Staples said that mentioning 
you are from SC could help 
since the exchange is not some-
thing they advertise. 
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By Shirley Allan 
 
 In Memory Tips,  I told you 
about removing the language 
folders that you don't need if you 
don't speak or read the language. 
I have found language folders in 
iPhoto, iMovie and iTunes and 
trashed them. I thought I had 
done a good job but just to 
check, I went to  File> Find and 
asked to find all the folders end-
ing in .lproj. Low and behold the 
computer found 3,432 more 
folders. Now that is just too 
much to ask for me to find and 
trash each folder individually, 
but now I have found a freeware 
program that will do it all for 
me. The site is:  h t t p : / /
www.bombich.com/software/
local.html. 
 I just used it and saved another 

529 MB of 
space remov-
ing the 3,432 
folders! I 
hope you en-
joy the easier 
way to rid 

yourself of all those unnecessary 
files. 

By Shirley Allan 
 
Looking back in my magazines I found a nifty article in MacWorld  
(August 2003) about saving  some memory on in OS X. How many of 
us use iPhoto in a language other than English? Not many I would as-
sume. However, because Mac's are sold world wide, Apple includes 
many languages in their proprietary programs. To save yourself just 
under 13 MB you can delete all but the English language from iPhoto.  
 
First, control click on the iPhoto application. From the contextual 
menu that pops up, chose Show Package Contents.  
Next, Open Contents>Resources. You will see a lot of files, but you 
are looking for the FOLDERS that end in .lproj and start with such 
interesting unidentifiable beginnings as da.lproj. Some are easy to rec-
ognize such as Dutch.lproj or Italian.lproj. There  were about 15 lan-
guage folders. You can drag these folders to the trash.  
 
I was careful and I would advise you to be too. I ran iPhoto to be sure 
that I hadn't drug an important file to the trash before I emptied it. If 
you mistakenly dragged something needed to the trash, just open your 
trash (double click) and drag the files back into Contents>Resources. 
The article says that there are a number of OS X programs that this 
will work with, but I have only tried it in iPhoto. If you are running 
OS X on the bare minimum of 128 MB of memory, you might want to 
get rid of these languages too. 
 
An older tip that I tell folks about in my AppleWorks classes is one  
that you should do periodically. That is to empty your Recent Items  
folder. In OS X, the Recent Items folder is found at: Go 
Menu>Home>Documents>AppleWorks User Data>Starting 
Points>Recent Items. Drag the documents you no longer want/need to 
the trash. Hold the shift key down and click on several to move more 
than one at a time. AppleWorks will continue to add ALIASES of 
every document you ever created to the Recent Items folder even if 
you have unchecked Recent Items in AppleWorks 
menu>Preferences>Topic>Files.  
 
Unchecking that "Recent Items" just controls the menu File>Open Re-
cent.  I forgot to check my Recent Items folder for a while (yes, teach-
ers forget sometimes to follow their own instructions), and I was 
floored by all the old aliases I found. Some wouldn't open because I 
had already trashed the original document. Now that is really clutter 
that I didn't need! I'll bet you have some too. 
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By Kerry Greene 
 

 Last month we learned how to add icons to 
your desktop.  Do you know that you can also 
place icons for frequently used programs in your 
taskbar right next to your Start button?  This area 
is called the Quick Launch Toolbar, and it is very 
handy for launching new programs when your 
desktop is already covered up with another win-
dow – no need to close or minimize the window, 
or dig through your Start Menu – just single click 
the icon in your Quick Launch! 
 To get the Quick Launch Toolbar, do the fol-
lowing: 
 

1. Right click on your taskbar in an open area 
to the right of the Start button 

2. Point to Toolbars – a sub menu will appear. 
3, Left click on Quick Launch - if it has a 

check mark next to it, then you already 
have it enabled. 

 
Adding icons to your Quick Launch is easy – 

simply drag them from your desktop (NOT 
FROM THE START MENU) down to the Quick 
Launch Toolbar and drop in place when you see 
the black ‘I’ beam.  This will COPY the icon 
without removing it from your desktop.   

If there is an icon in your START MENU that 
you would like added to your Quick Launch, first 
send it to your desktop using the following steps, 
then drag it into your Quick Launch Toolbar. 
 

1. Click on Start. 
2. Point to All Programs. 
3. Find the icon in your list of all programs (if 

it is in a folder, point to the folder to reveal 
the contents). 

4. RIGHT CLICK on the icon you wish to 
copy. 

5. A menu will appear – point to “Send To 
”. 

6. A sub-menu will appear – left click on 
“Desktop (create a shortcut)”. 

7. Click on Start again to reveal your desktop 
– and you are done – you will see your new 
desktop shortcut. 

8. Now point to the icon and hold down the 
left mouse button while dragging the icon 
into your Quick Launch Toolbar – release 
the left mouse button when you see the 
black “I” beam in the desired location. 

 

Deleting unwanted shortcuts from your desktop 
or Quick Launch Toolbar is just as easy – 
RIGHT CLICK on the icon to produce a menu, 
and then left click on “Delete” – the icon will be 
removed and placed in the Recycle Bin after you 
respond to the confirmation message.  This will 
only remove the shortcut to the program and not 
the program itself.  You will know it is a shortcut 
icon to a program by the small black arrow in a 
white box that is displayed with the icon on your 
desktop. 
  

 
 
 
 

 
Mac SIG did not meet in 
December so there is no 
meeting  report. A meeting 
is planned for January  16 
at 9:AM in the computer 
lab. 

 
 
 

 
 
 
 
 
 
The Internet SIG will meet 
on January 13, at 7:PM in 
the computer lab. 

 
 
 
The Digital Art 

SIG meets on Saturday, Jan. 
17, at 12 noon.  Come in a 
learn more about the artistic 
possibilities of a computer. 
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Day Date Time Class Book Teacher 
  
Fri. Jan 2 2:00 Email using Outlook Express Part 3 (PC/Mac) 7 Kerry Greene  
Sat  Jan 3  10:00 to 12:00 Open Lab     
Mon  Jan 5 8:00 Word 1 – Creating a Basic Letter (PC) 2 Walter Goldsmith 
  9:00 Word 2 – Revising a Basic Letter (PC) 2 Walter Goldsmith 
  1:00 Having Fun With Photoshop – Part 1 (PC) 6 John Wolfersberger 
  2:00 Free Digital Slideshow Programs (PC) 6 Larry Allen 
  3:00 Free Digital Slideshow Programs (PC) 6 Larry Allen 
  4:00 PhotoShop Elements 2 – Part 1 (Mac) 1 Eleanor Gabel 
  7:00 Beginning PC/Windows 1 – Using the Mouse 3 Jim Calvert  
Tues Jan 6  2:00 Burning CDs (PC) 9 Jim Calvert 
  7:00 Beginning PC/Windows 2 – Working with the Keyboard 3 Jim Calvert  
Wed Jan 7 8:00 Self Test Your PC Security 11 Dick Franzen 
  1:00 Creating and Sorting Lists With AppleWorks  (Mac) 1 Shirley Allan 
  2:00 REALLY Basic Internet (PC/Mac) 7 Dave Allan 
  3:00 Basic Research & Tracking Stocks on Internet (PC/Mac) 7 Dave Allan 
  7:00 Beginning PC/Windows 3 – Working with Files 3 Jim Calvert  
Thurs Jan 8 8:00 Manage your Finances with Quicken 1 (PC/Mac) 8 Jim Chapman 
  9:00 Using Pictures on a Disc From a nondigital camera. 6 Golden Gals 
  3:00 Word 6 – 1 ½ hours (PC) 2 Jan Grenert 
  7:00 Beginning PC/Windows 4 – Saving Files to a Disk 3 Jim Calvert  
Fri Jan 9 8:00 Word 1 – Creating a Basic Letter (PC) 2 Shirley Celli 
  9:00 Word 2 – Revising a Basic Letter (PC) 2 Shirley Celli 
  1:00 Excel 1 (PC) 5 Walter Goldsmith 
  2:00 Excel 2 (PC) 5 Walter Goldsmith 
  4:00 Printshop Greeting Cards 1 (PC) 4 Doris Keniry 
  7:00 Beginning PC/Windows 5 – Introducing Spreadsheets 3 Jim Calvert  
Sat Jan 10  10:00 to 12:00 Open Lab     
Mon Jan 12 8:00 Word 3 - More Letter Basics (PC)   2 Walter Goldsmith 
  9:00 Word 3.5 Envelopes and Labels (PC) 2 Walter Goldsmith 
  1:00 Having Fun With Photoshop – Part 2 (PC) 6 John Wolfersberger 
  2:00 Greeting Cards 1 – 2 hour class (Mac) 1 Lyn Morse 
  4:00 PhotoShop Elements 2 – Part 2 (Mac) 1 Eleanor Gabel  
Tue Jan 13 1:00 Scanner 1 (PC/Mac) 6 Pete Claar 
  3:00 Greeting Cards 2 – 2 hour class (Mac) 1 Lyn Morse 
  7:00 Internet SIG     
Wed Jan 14 9:00 Windows Maintenance and Organization (PC) 12 Charley Voelker 
  1:00 Basic Beginning Macintosh 1 Shirley Allan 
  2:00 Burning CDs 9 Jim Calvert 
  3:00 REALLY Basic Internet (PC/Mac) 7 Dave Allan 
  4:00 Basic Research & Tracking Stocks on Internet (PC/Mac) 7 Dave Allan 
  7:00 Digital SIG     
Thurs Jan 15 8:00 Manage your Finances with Quicken 2 (PC/Mac) 8 Jim Chapman 
  9:00 Transfers, Bookmarks, and Other Crafts. From your 6 Golden Gals  
   Photos. (PC) 
  1:00 Beginning PictureIT (PC) 6 Helene Barker  
  2:00 Beginning Creating a Photo Album With PictureIT (PC) 6 Helene Barker  
  3:00 Word Art - 2 hours (PC) 2 Jan Grenert  
Fri Jan 16 9:00 Mac SIG   
  1:00 Excel 3 (PC) 5 Walter Goldsmith 
  2:00 Excel 4 (PC) 5 Walter Goldsmith 
  4:00 Printshop Greeting Cards 2 (PC) 4 Doris Keniry  
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Day Date Time Class Book Teacher  
 
Sat Jan 17 10:00 to 12:00 Open Lab    
  12:00 Digital Art SIG     
Mon Jan 19 8:00 Mac Maintenance Tips 1 Kent McDonald 
  9:00 Beginning PC/Windows 1 – Using the Mouse 3 Kerry Greene 
  1:00 Having Fun with Photoshop – Part 3 (PC) 6 John Wolfersberger 
  2:00 Free Digital Slideshow Programs (PC) 6 Larry Allen 
  3:00 Free Digital Slideshow Programs (PC) 6 Larry Allen  
Tues Jan 20 9:00 Beginning PC/Windows 2 – Using the Keyboard 3 Kerry Greene 
  1:00 Scanner 2 (PC/Mac) 6 Pete Claar 
  2:00 Board Meeting     
Wed Jan 21 8:00 Self Test Your PC Security 11 Dick Franzen 
  9:00 Beginning PC/Windows 3  - Working with Files 3 Kerry Greene 
  1:00 Taming Jaguar Class 1 - (0S 10.2X) Mac 1 Shirley Allan 
  3:00 Greeting Cards 3 – 2 hour class (Mac) 1 Lyn Morse 
  7:00 Windows SIG     
Thurs Jan 22 8:00 Manage your Finances with Quicken 3 (PC/Mac) 8 Jim Chapman 
  9:00 Beginning PC/Windows 4 - Saving Files to a Disk 3 Kerry Greene 
  1:00 Having Fun with Photoshop – Part 4 (PC) 6 John Wolfersberger 
  2:00 Burning CDs (PC) 9 Jim Calvert 
  3:00 Word 4 – 1 ½ hours (PC) 2 Jan Grenert  
Fri. Jan 23 8:00 Word 3 - More Letter Basics (PC)   2 Shirley Celli 
  9:00 Word 3.5 Envelopes and Labels (PC) 2 Shirley Celli 
  1:00 Internet for Beginners (PC/Mac) 7 Kerry Greene 
  2:00 Printing your Photos – 2 hours (PC) 6 Donna Szostak 
  4:00 Printshop Greeting Cards 3 (PC) 4 Doris Keniry  
Sat Jan 24  10:00 to 12:00 Open Lab     
Mon. Jan 26 9:00 Windows XP – Beyond the Basics Part 1 (PC) 3 Kerry Greene 
  1:00 Email for Beginners (PC/Mac) 7 Kerry Greene 
  3:00 Print Explosion Workshop – 2 hour class (Mac) 1 Lyn Morse 
  7:00 Beginning PC/Windows 1 – Using the Mouse 3 Jim Calvert  
Tues Jan 27 9:00 Windows XP – Beyond the Basics Part 2 (PC) 3 Kerry Greene 
  2:00 General Meeting   
  7:00 Beginning PC/Windows 2 – Working with the Keyboard 3 Jim Calvert  
Wed Jan 28 9:00 Windows XP – Beyond the Basics Part 3 (PC) 3 Kerry Greene 
  1:00 Taming the Rest of Jaguar – Class 2 (0S 10.2X) Mac 1 Shirley Allan 
  7:00 Beginning PC/Windows 3 – Working with Files 3 Jim Calvert  
Thurs Jan 29 8:00 Manage Your Finances with Quicken 4 (PC/Mac) 8 Jim Chapman 
  9:00 Map Your Journey with Streets and Trips (PC) 8 Jim Chapman 
  1:00 Scanner 3 – Photos to Email (PC/Mac) 6 Pete Claar 
  4:00 Printshop Greeting Cards 4 (PC) 4 Doris Keniry 
  7:00 Beginning PC/Windows 4 – Saving Files to a Disk 3 Jim Calvert  
Fri Jan 30 9:00 Windows XP – Beyond the Basics Part 4 (PC) 3 Kerry Greene 
  7:00 Beginning PC/Windows 5 – Introducing Spreadsheets 3 Jim Calvert  
Sat Jan 31  10:00 to 12:00 Open Lab    
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Class Date Time 
AppleWorks series (Mac) 
   Creating/Sorting Lists 1-7 1:00 
Basic Research & Tracking 1-7 3:00 
    Of Stocks & Mutuals  (Mac/PC) 
Basic Research & Tracking 1-14 4:00 
    Of Stocks & Mutuals  (Mac/PC) 
Beginning PC series 
  1   The mouse 1-5 7:00pm 
  2   The Keyboard 1-6 7:00pm 
  3   Working w/ Files 1-7 7:00pm 
  4   Saving Files to disk 1-8 7:00pm 
  5   Introducing Spreadsheets 1-9 7:00pm 
  1   The mouse 1-19 9:00 
  2   The Keyboard 1-20 9:00 
  3   Working w/ Files 1-21 9:00 
  4   Saving Files to disk 1-22 9:00 
  1   The mouse 1-26 7:00pm 
  2   The Keyboard 1-27 7:00pm 
  3   Working w/ Files 1-28 7:00pm 
  4   Saving Files to disk 1-29 7:00pm 
  5   Introducing Spreadsheet 1-30 7:00pm 
Basic Beginning Macintosh 1-14 1:00 
BOARD MEETING 1-20 2:00 
Burning CDs on a PC 1-6 2:00 
Burning CDs on a PC 1-14 2:00 
Burning CDs on a PC 1-22 2:00 
DIGITAL SIG  1-14   7:00pm 
DIGITAL Art SIG  1-17    noon 
E-mail w/ Outlook Express  1-2 2:00 
E-mail for Beginners (PC/Mac) 1-26 1:00 
Excel 1   (PC) 1-9 1:00 
Excel 2   (PC) 1-9 2:00  
Excel 3   (PC) 1-16 1:00 
Excel 4   (PC) 1-16 2:00 
Free Digital Slideshow programs 1-5 2:00 
Free Digital Slideshow programs 1-5 3:00 
Free Digital Slideshow programs 1-19 2:00 
Free Digital Slideshow programs 1-19 3:00 
GENERAL MEETING 1-27 2:00 
Greeting Cards  - Print Explosion  -Mac 
Greeting Cards 1 1-12 2:00+ 
Greeting Cards 2 1-13 3:00+ 
Greeting Cards 3 1-21 3:00+ 
Print Explosion Workshop 1-26  3:00+ 
Greeting Card series - Print Shop - PC 
Greeting Cards 1 1-9  4:00 
Greeting Cards 2 1-16 4:00 
Greeting Cards 3 1-23 4:00 
Greeting Cards 4 1-29 4:00 
Internet, REALLY Basic(Mac/PC) 1-7 2:00 
Internet, REALLY Basic(Mac/PC) 1-14 3:00 
INTERNET SIG 1-13 7:00pm 
Internet for Beginners (PC/Mac)1-23 1:00 
MAC SIG 1-16 9:00 
Mac Maintenance Tips 1-19 8:00 
Map Your Journey with  1-29 9:00 
       Streets and Trips 

Class Date Time 
PhotoShop series (PC) 
   PhotoShop, Fun with…pt. 1 1-5 1:00 
   PhotoShop, Fun with…pt. 2 1-12 1:00 
   PhotoShop, Fun with…pt. 3 1-19 1:00 
   PhotoShop, Fun with…pt. 4 1-22 1:00 
PhotoShop Elements 2 series (Mac) 
   PhotoShop Elements, pt. 1 1-5 4:00 
   PhotoShop Elements, pt. 2  1-12 4:00 
Picture It Series - PC 
   Beginning Picture It   1-15 1:00 
   Creating a Photo Album 1-15 2:00 
Print Explosion Workshop 1-26 3:00+ 
Printing Your Photos 1-23 2:00+ 
Quicken series 
   Manage Your Finances, pt. 1 1-8 8:00 
   Manage Your Finances, pt. 2 1-15 8:00 
   Manage Your Finances, pt. 3 1-22 8:00 
   Manage Your Finances, pt. 4 1-29 8:00 
Scanner Series 
   Scanner Basics 1  1-13 1:00 
   Scanner 2  1-20 1:00 
   Scanner 3 -  Photo to e-mail 1-29 1:00 
Self Test your PC security 1-7 8:00 
Self Test your PC security 1-21 8:00 
Jaguar Series – OS X 
    Taming Jaguar OS X, pt. 1 1-21 1:00 
    Taming the Rest of Jaguar 1-28 1:00 
Transfers, Bookmarks, etc 1-15 9:00 
  From your Photos 
Using Pictures on a disc from 1-8 9:00 
  A nondigital camera 
Windows Maintenance  1-14 9:00 
        And Organization 
WINDOWS SIG 1-21 7:00pm 
Windows XP Beyond Basics 1 1-26 9:00 
Windows XP Beyond Basics 2 1-27 9:00 
Windows XP Beyond Basics 3 1-28 9:00 
Windows XP Beyond Basics 4 1-30 9:00 
Word Art  (PC) 1-15 3:00+ 
Word Series - PC 
Shirley Celli 
 1   Creating a Basic Letter 1-9 8:00 
 2   Revising a Basic Letter 1-9 9:00  
 3   More business letter basic 1-23 8:00 
 3.5   Envelopes and Labels 1-23 9:00 
Walter Goldsmith 
  1   Creating a Basic Letter 1-5 8:00 
  2   Revising a Basic Letter 1-5 9:00  
  3   More Business Letter basic 1-12 8:00 
  3.5   Envelopes and Labels 1-12 9:00 
Jan Grenert 
  Word 6 1-8 3:00 
  Word 4 1-22 3:00 
  Word Art 1-15 3:00+ 
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 BOARD MEETING 
Jan.. 20, 2:00 P.M. 
 

INTERNET SIG 
Jan.. 13, 7:00 P.M. 
 

DIGITAL SIG 
Jan . 14, 7:00 P.M. 
 

WINDOWS SIG 
Jan.  21, 7:00 P.M. 

GENERAL MEETING 
Jan. 27, 2:00 P.M. 
 
DIGITAL ARTS  SIG 
Jan. 17, 12:00 Noon 
 
MAC SIG 
Jan. 16,  9:00 A.M. 

“Let’s Compute” Officers 
Sheldon Plotkin, President......................................360-0789 ......................................sunctyplot@aol.com 
Lyn Morse, VP Programs .......................................345-4466 ........................................lynmorse@aol.com 
Kent McDonald, VP Communications...................345-2931 ............................ rkmcdonald@earthlink.net 
Jim Calvert, VP Education .....................................772-6710 ........................................jim2anna@aol.com 
Jan Grenert, Secretary, Newsletter Editor ..............360-9085 .......................................bgrenert@dc.rr.com 
Dave Allan, Treasurer.............................................345-5087 ........................................DYAllan@aol.com 
Pete Claar, Member-At-Large ................................772-9509 ....................................zadhoc@hotmail.com 

January Lab Monitors 
Felice Bourne  Ree McCarthy 
Pete Claar Murray Ross 
Shirley Cronin Leonette Rowe 
Bill Crowley Jim Schlienz 
Frank Diaz Norma Streeter 
Jack Drill Charlie Voelker 
Jan Grenert Rod Walling 

Shirley Cronin, Monitor Coordinator  

January Teachers 
Dave Allan................................................... 345-5087 
Shirley Allan................................................ 345-5087 
Larry Allen .................................................. 200-0972 
Helene Barker.............................................. 360-5713 
Jim Calvert .................................................. 772-6710 
Shirley Celli................................................. 345-7159 
Jim Chapman............................................... 200-9296 
Pete Claar .................................................... 772-0509 
Liz Ferrel ..................................................... 360-1376 
Dick Franzen ............................................... 772-4539 
Walter Goldsmith ........................................ 772-8448 
Kerry Greene ............................................... 200-1551 
Jan Grenert .................................................. 360-9085 
Doris Keniry................................................ 345-3464 
Kent McDonald ........................................... 345-2931 
Lyn Morse ................................................... 345-4466 
Donna Szostak............................................. 360-7500 
Charlie Voelker ........................................... 345-0123 
John Wolfersberger...................................... 772-7297 

Bits & Bytes is distributed to 
current members of the SCPD 
“Let’s Compute” Computer 
Club, which provides this 
publication for informational 
purposes only.  The club 
neither endorses nor promotes 
any of the products or ser-
vices that have been men-
tioned or suggested herein, or 
at any meeting, and assumes 
no responsibility or liability 

Publication of the SCPD 
“Let’s Compute” Computer Club 

Address Correspondence to: 
Bits & Bytes 

38180 Del Webb Blvd. 
Palm Desert, CA  92211 

e-mail: letscomput2@aol.com  


